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1. Introduction to the Gryphon LCP

The Gryphon LCP is a small, fast and affordable option for setting up Lipidic Cubic
Phase (LCP) sandwich plates and bicelle assays, as well as traditional protein
crystallography plates. The dedicated syringe based LCP dispenser is used for the protein
and a 96 head is used for the screening solutions. A 96 well sandwich plate can be sealed
in less than 2 minutes. LCP drops are set up in 45 seconds. An optional non-contact
Nano dispenser can be added at anytime to set up vapor diffusion sitting drop and
hanging drop plates. The non contact dispenser can also be used for additive experiments.

Gryphon Specifications

Dispense Volumes
96 Head: 100 ul syringes deliver 100 nL to 100 pL
LCP Syringe: 100 pL syringe delivers 10 nl + with short LCP needle, optional long tip
is available for serial dilution work.
Size
Base: 20in (51 cm) H x 23 in (59 cm) W x 23 in (59 cm) D
68 Ibs (31 Kg)

Wash: 13in(833cm)H x6.5in (17 cm) W x 14 in (36 cm) D
5.51bs, 2.5 (kg)

Nano: 9.5in (24cm)H x6in (15 cm) W x 16 in (41cm) D
18.5Ibs, 8.4 Kg
Electrical
Base: 120/240 Vac, 3 A, 50/60 Hz
LCP Arm: Integrated Power
Software
Windows .NET
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Features of the Gryphon LCP system

Two assay positions—source and destination plate positions; 8 position serial dilutor
extension; LCP Mixing Station; LCP Pre-dispensing Station; 1 96 way Head wash
Station.

Multiple-syringe drive Head selection—accommodates 24, 96, or 384
interchangeable syringe head configurations

Two 96 channel needle types available—Teflon coated stainless steel needles or
flexible Nitinol needles

Multiple dispense options: dispenses into 96-, 384-, or 1536-well plates into
commercial protein crystallography plates

Microsoft Windows-based software

Closed-loop motion control on each axis—task completion verified via encoders on
each motor

2. Safety

Study these safety instructions before you use the instrument.

1.

Heed all Caution statements in this manual and adhere to the Danger and Warning
labels on the instrument:

Know how to shut down the instrument in an emergency.
Practice good laboratory techniques to minimize hazards.

Contact your ARI representative for instructions before you attempt any maintenance
or service procedures.

Stopping the Instrument in an Emergency

To stop the system in an emergency, click @ on the main screen.

To restart the system after an emergency shutdown:

1.

Inspect the system components. If any are physically damaged, recovery is not
possible.

Verify that it is safe for the run to continue:
e Clean up any spills.
» Replace any containers have been misplaced or dropped.

» Ensure that the stage area is free of obstructions.

If the system components are not damaged and it is safe to continue, power off the
Gryphon; then turn it back on.
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4. Disconnect and reconnect the software.
5. Verify LCP Syringe is disengaged.

6. Restart the run in the Gryphon software.

Following Good Laboratory Practices

Turn off the system and unplug the power cord before you perform any service or
maintenance tasks.

Handle chemicals carefully, following manufacturers’ safety instructions for their use,
storage, and disposal.

Set your aspirate and dispense heights so that the needle tips never touch the bottom of
the receptacle. If this occurs, backpressure building in the syringes could cause the
glass syringe barrels to crack or break.

Exception: You can safely dispense volumes of less than 1.0uL onto a dry plate with
the needle tips touching the plate.

Moving the Gryphon Instrument
The Gryphon instrument weighs 92 Ibs (41.9 Kg). If you must move the instrument,

prevent injury to yourself or damage to the instrument by taking the following
precautions:

» Lift the Gryphon only from the front and sides. Do not lift the Gryphon from the rear.
» Be sure that you are lifting the unit by the base and not just by the enclosure.

3. Getting Started

The Gryphon system—as delivered—has the basic parameters installed, but you will
need to understand the following concepts.

Configuration Settings

1. Configuring the Motor Engine. These fields have been correctly calibrated prior to
installation.

2. Configuring Global Settings. Although these fields are also correctly calibrated at
installation; you may need to edit this screen to suit your specific configuration.

3. Calibrating the Stage. The system will be correctly calibrated when installed.
Thereafter, recalibrate only if you move the system, or if you need to remove the
head or have damaged the LCP syringe tip.
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4. Defining Labware. The system is preconfigured with a large number of commercially
available labware options. You can edit existing categories or create new ones
whenever you want to use a new type of labware in your protocols

Writing Protocols

The Gryphon system is protocol-based. You can save the protocols you create and use
them over and over again. You can also edit existing protocols, as well as create new
ones.

This guide describes how to complete these tasks and how to run the protocols.

Launching the Program

Turn on the Gryphon LCP system and computer and click the Gryphon icon to launch
the Gryphon program. Begin by accessing the Configuration menu at the top left of the
screen.

4. Configuring the Motor

The Gryphon motor engine is appropriately configured at installation. To reach this
screen, click Configuration - Configure Motor Engine.
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Motor Configuration Editor

Serial Ponl COME v Ganbral Seliigs Motor Testing

(Addiote ) (C Belee ) (Mot Name| )
Mator Mame. Asis (Axis Nama| ] [Numbaﬂ ) (JUse Encoder
Stage InOut X1
SIaige Left Fught 52 (Lead Screw Pllchl W [Uml | W
Mano Head 1
B L (
96 Hoad 52 (Step Per Fevl j (Encoder Step Per Fev| j
Syringes =] Direct H nd
L 5 (Dirsction | ) (Home Index] )
Solo Syringe  SL Wiin Position| m Wigx Fosition |
(Acosteration] ) (Maxveloay] ] @ y
(Fast Home Speed | ) (Blow Home Speed | ) (Mol )
(O use sta Stal Limit| (0 Use Postiion Maintenance
(Rum Current | ] (Hu\d Current] j (Dlgl\a\ Filter Delay! ]
Input/Output Configuration Programs [ use Safe Height
104 |Mods ‘Amive QOn ‘ ame ‘Address | # |Listing
(Name|
(Addresﬂ ]
(poiveon] ) [ mavedl ) (Save A& Close) ([ Cancel & Class )

The Gryphon deck motors are usually configured on COM 5 at ARI. This teach field is
used to define the minimum and maximum positions.

Note that the Serial Port in the upper left of the screen is set to 1 to 9, depending on the
computer that shipped with the system. Of the 9 possible settings, 6 through 9 are
reserved for a Nano Dispenser. The correct Com Port assignments can be found in the
Windows Device Manager.

(SerialPor|coms )

COm1
COmM2
COm3
o4
COmb
COME
CO7
COmME
COmg

| ——

The Gryphon main deck motor engines are usually on COM 5. Please contact ARI prior
to making any changes to the preconfigured Serial Port settings.

5. Configuring Global Settings

The Global Settings are also preconfigured, but there are a number of edits you may
want to make, depending on your system. LCP specific settings are outlined here.
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Global Settings comprises three areas. Click Configuration - Configure Global
Setting.

Adapter Type  describes the deck layout of the LCP  option.

Global Configuration

=yringe Head TypelheadEE

(
(Sola Head Type| LCP
(

Mano Head Typelnanu:ﬂ

[Wash Type | Flowe Thraugh

[ﬁ-‘ad apter Type | LCF Aspirate Extension
LanguagelEn none
LCF

LCF Deck Extension
LCF Aspirate Extensian

e aariG
‘-\_‘J‘-\_J‘-\_J‘-\_JM_J

e,

None means no LCP adapter is selected.
LCP means an adapter plate, no longer in the current system

LCP Deck Extension is the metal, bolt-on adapter for the glass slide pre-dispense
location

LCP Aspirate Extension includes the Deck Extension locations plus the White Vial holder

6. Calibrating the LCP Syringe to the Stage

Your ARI representative will calibrate the stage when the system is installed.

ACAUTION| Study the safety information for this instrument before you

operate it and always follow the Cautions in this guide as well
as the Dangers and Warnings on the instrument’s labels.

We recommend that teach points are checked if the system is moved or if new
equipment is installed.

Gryphon LCP Setup Guide 7



Training the deck involves the following sections:

The syringe with short needle to deck positions 2 (Gryphon right deck), 5 (LCP

adapter stage placed on right deck), 6 (LCP predispense slide).
Position 9 for coupled mixing syringes for mixing processes.

Position 13 accessed with ARI long needle on 8-way diluter stage.

1. Select Configuration - Calibrate Stage to reach the Calibrate Stage screen.

Calibrate Stage

Trays Edition
S Mumber: ¥|Level Current Positi
1 1 ~
sty 5 2 1| (=l ) 000
e 3 B (] ) G
13 5 i 4
7 G & 5 1 [zl ] 000
. 9 1
Mty Mty emply 0 1
1 1
e 2 1 §
5 T2 [ (cotor|
00
Taal (M) Teach 85 Syringes Head
OO C\ Teach Nano Dispenser Head
() Teach Solo Syinge
Step Jog
Engine Control
o) (B -
v \
(Step Size (mm) | 9.00 ) (_Sae ) ((SoveéClbse ) (Concel@cCioss )

2. Under Engine Control at the bottom left of the screen, click Connect.

ACAUTION  Make sure the LCP syringe is disengaged before homing.

If you need to stop the calibration movements at any time, click

Stop under Engine Control.

Beginning Calibration

The arrows at the bottom of the screen move the head and | N
tray shelf in a step-wise mode. A
e Use the arrows in the larger control area to move the 4 b D

stage left and right and forward and back. Vv

* Use the arrows in the control area on the right to move (G 5 umla00

the Z height up and down.
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Use large steps to begin adjusting the XY and Z positions, and then smaller step sizes
selected in the pull-down menu as you approach the nesting position.

To move to an existing XY position quickly—for example, if you want to check the setting
or modify it—click Go Above Position or Go to Z Level.

ACAUTION| Because going to Level Z is the mostly like time that a crash can

occur, we recommend using the step function to reach this level.

Each mouse-click moves the head one step. You can set the size of the step in the Step
Size (mm) control box below the Step Jog arrows.

Use a larger step size when the syringe is far above or far to the left or right of the
calibration holes; use a smaller step size when calibration target and needle are closer
together.

Calibrating the Plate Position

Calibrating Plate Deck Position 2

Gryphon deck position 2 can be used for typical plate setups on the Gryphon that
could contain normal protein mixtures, bicelle mixtures orLCP mixtures to be
used with typical protein crystallization plates. It is generally not recommended
for LCP highly hydrophobic plates.

3. Click Number 2/Level 1 in the table at the top middle of the screen:
( 3 | [ MNurnber  ¥|Lewel Cutrent Position

1 ; .
(= ) 000
(1 ) n.oo

empty

1
z
3
5
B

1
ER S
1 ] G 1 (z] ) il
empty empty empty %
1 1
B 1 § i
5 O (Calar| )
empy
10
= OO (W) Teach 96 Syringes Head
OO {_ Start Teaching [ Teach Mano Dispenser Head
4, [:]Teach Soln Syrinne
(] Teach 36 =yringes Head
i _— Teach Mano Dispenser Head
| Start Teaching M
5. (O] Teach Sola Syinge Center-screen, select the Teach

Solo Syringe (LCP) on the system.. Then click Start Teaching.
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6. Now use the vertical up/down Step Jog arrow to adjust Z height and the XY cross-
hair adjustments to maneuver the tip and find the small hole in the deck nest
position.

7. The teach points are the origin for all the instrument’s movements. For deck position
2 the teach point is located towards the front of the deck as indicated in the above
picture. Deck positions 5,6,9 and 13 use teach points toward the rear of the unit.

8. Using the included .002"/.05mm feeler gauge, drive the head down in Z until the tip is
as close to the shim as possible, but the shim is free to slide.

9. Change the Z motion step size to 0.05mm, move Z until the tip just pinches the feeler
gauge. Do not over pinch, or let the shim be free to slide.

10. Move the Z axis up 1x 0.05 mm click, remove feeler gauge, and then move it back
down into the trained position.

11. Click Update XY Tray Position and Update Z.
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12. Click Save - Stop Teaching.

Repeat the calibration steps for Deck Positions 5, 6, 9, and 13 as follows.
Calibrating LCP Adapter Position 5

The LCP plate adapter is generally recommended for LCP highly hydrophobic
plates.

To teach LCP adapter position 5, place the adapter on the right deck over
position 2.

NOTE To teach position 5, place the slide adapter plate onto position 2,
making sure it is flat and securely positioned before teaching.

1. Click Number 5/Level 1 in the table.

2. Repeat the same motions as configured above for position 2, with the syringe LCP
tip and the feeler gauge.

3. The teach point position is now located to the rear of the LCP dispense adapter
platform.

4. Maneuver the XY stage and Z height and check with feeler gauge as explained
above.

5. Click Update XY Tray Position and Update Z.

6. Click Save & Close.
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Calibrating LCP Adapter Predispense Stage position 6:

This is the pre-dispense slide useful to initiate the LCP dispense process.
1. Position 6 teach point is in the upper left corner of the adapter.

2. Click Number 6/Level 1 in the table.

3. Follow the same calibration instructions as for deck positions 2 and 5.

4. Teach position with feeler gauge as explained above.

5. Click Update XY Tray Position and Update Z.

6. Click Save & Stop teaching to continue or alternatively Click Save & Close to

close the teaching module.

Calibrating LCP Coupled Syringe Mixing Position 9

1. Before starting teaching, make sure LCP top bracket is far enough away from
syringe plunger. See section called Exchange Solo Syringe.

2. Assemble an LCP syringe pair, making sure to securely tighten all fittings.

Gryphon LCP Setup Guide
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3. Place syringe assembly into position. Coupling goes onto “middle” bracket.

4. Push bottom syringe plunger all the way up, so that all of the mixture is located in the
upper syringe body raising the upper syringe plunger by doing so.
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Failure to teach mix position correctly may cause the syringe
pair to break in actual use.

ACAUTION

5. Make sure top and bottom syringes are visually aligned vertically.
6. Click Number 9/Level 1 in the table at the top middle of the screen:

3 Bumber ¥|Level

1

[
ER
1
fi 1
E 1
empty 0 1
1 1
1
E

Current Position

(I ) 0.00
] )
) n.00

empty

0.00

ok
B

o || R |

(zl

ermnpty ety

|‘CU|D!’| J

emey
110 oo () Teach 96 Syringes Head
OO Start Teaching 8Teach Mano Dispenser Head
Teach Solo Syringe
() Teach 95 Syringes Head
( Start Teaching | () Teach Nano Dispenser Head
(] Teach Solo Syings
7. Center-screen, select Teach Solo Syringe on the system. Then click Start

Teaching.

8. Now use the XY cross-hair adjustments to maneuver the syringe plunger end
and find the mixing nest position in XY.

9. _ yertica!ly adjust until the syringe plunger end is just touching the spring loaded
mixing position.

10. Change Z Step Jog size to 1.0mm.

11. Move down 1.0mm in Z height depressing the spring loaded stage position 1mm.

12. Click Update XY Tray Position and Update Z.

13. Click Save - Stop Teaching.

14. Click Save & Close.

Gryphon LCP Setup Guide

You will notice the spring is depressed 1 mM on each cycle during the
mixing process. If the coupling stops depressing the spring and
begins to move above position 9, the syringe coupling is likely leaking.
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Calibrating LCP Deck Position 13

Deck position 13 is a vial rack that contains 8 positions. This module is effective for
performing aspirating and dispensing solutions from, mixing solutions, performing serial
dilutions, and it is useful for crystal seeding experiments.

NOTE Position 13 Al is the vial location furthest away from the user.

This location is intended to be used with the long nozzle version
syringes.

Place a 0.2 mL PCR tube that the rack is defined for in position 13 A1l.
Click Number 13/Level 1 in the table.

3. Train the long ARI needle tip to the center in XY and bottom of the PCR tube for Z
height using the same movements specified for the other teach positions. Ensure
the needle is near thetube bottom,clearby enough to slightly move the tube.

Click Update XY Tray Position and Update Z.

5. Click Save & Stop teaching to continue or alternatively Click Save & Close to
close the teaching module.

7. Defining New Labware

Defining labware is “teaching” the system the physical parameters of the labware pieces
you will use in your protocols. Most labware manufacturers provide the required
dimensions. ARI can also provide this information.

This is the same operation as in the general section as already in the manual.

You can define not only the parameters for different well types on the same plate, but
also different depths and needle-tip-to-well-center orientations for the same well. Each of
these single definitions is called a “layer.”

To define labware for the Gryphon:
1. Have calipers ready to measure the dimensions of your labware.
2. Launch the Gryphon program.

3. On the main menu, click Configuration - Open Labware Editor.
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Phoenix Labware Editor

8.

(Rescan Labware Diredny) (_Create NewLatwere | [ Delete Laoware |
Nams |Maker [Tupe [ 4] (aree] )
W-groove Resenor Ruobibing 96 Wells [Makerl ] (Creatml ]
no plate 1536 ir 1536 Wells
Teflon Film Frame MNeuro Probe 36 Wells [Fnrmall ] Labwars Heigml
96 well clear micratiter 96 WWells Ocomerinal () Comerinalz
Deap Well -1 ml Nunc 96 Wells C]Cnrnarm H1 C]Cnrnarm H12
3 Rewell Coming - 3552 Corning 96 Wells Layer Name |
192 xtal Corning 36 Wells
Smaked Clear Flaiz AR 384 \ells
Reservoir MNunc 96 Wells
Intelli-Plate-Flat AR 96 Wells
1536 - Clear - Square Greiner 1536 Wells
CostarDeepth Costar a6 Wells
96 Bottarn Costar 96 ‘Wells
smoked clear plate ir 384 Wells Degth (mm)l
S0-2 Crystal Plats Innowvaplate 36 Wells
Emerald Screen Emereld 98 Wells Layer Center (relative to well center)
Hampton Screen Hampton 96 Wells % (mm) |
Ererald Clover Jr 1 well Ermerald 96 WWells
1536 Clear square nung 1536 WWells ¥ (e |
Qial Qiagen a6 Wells Lver Size and Shane
QIA003.02 Qiagen 95 Wellz v P
Feservoir3sd Hunc 384 Wells | wiclth (mrm) |
D CEEED G (oo ioe Festia]
Shapal
Close Lakbware Editor

Click Create New Labware.

In the upper right, enter a Name, Maker and Creator for the labware. (Maker and
Creator values are optional.)

[Namellntelliplate ]

(MakerIFiDbbins ] [CreaturlDavid YWright ]

Select a format from the Format drop-down list.

(Farmat| 36 wells v

384 Wells
1536 Wells

If you did not receive the labware's exact height measurement from the
manufacturer, measure the overall height of your plate. Enter the value in Labware
Height.

[Labware Heightl 15 ]

Click the Corner option that applies to your plate (the corners that are notched).
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(Farmat| 96 walls J
C] Corner in Al D Cornerin A12

C] Corner in H1 D Cornerin H12

9. Click Add Layer [ AddLayer \_I | Delete Layer \‘|
10. Enter Name and Depth for that layer. (Depth = distance from the top of the plate to
the bottom of well.)
11. Enter the distance from the center of the layer to the center of the well. If the layer
and well center are the same, then values for X and Y will be 0.)
12. Enter Layer Width and Height; then select the shape of the layer. The plate definition

creates a graphic illustrating the values you have entered.

|Mame |Fasaroir J

(Depth (mm)| 12 )

Lawer Center (relative to well center)

(% mm) [2.25 )

(¢ framy [0 )

%
A £
Lawer Size and Shape
(wictth (rmrm) |4 )
(Height frim) |8 )

I"Shape Sguare J

i il i it

LCP labware may need modified height settings. The software is
constrained to dispense within the well depth, which for an LCP slide
may only be the depth of the tape (e.g. ~0.15mm). A dispense
height higher than this may be desired, especially for larger volume
dispenses.

To increase the available dispense height the Labware Height and
Well Depth may be modified. For example, a 1mm glass slide has a
tape layer that is 0.15mm deep. The nominal Labware Height and
Well Depth are therefore 1.15mm and 0.15mm respectively.
Changing the Labware Height and Well Depth to 1.5mm and 0.5mm
respectively will maintain the correct 1mm glass thickness and allow
additional dispense height adjustability. The Labware Height and
Well Depth MUST be adjusted together.

ACAUTION Failure to adjust both Labware Height and Well Depth together
may result in a plate definition that will damage the needle.
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8. Writing Protocols

This is similar to the way the general Gryphon manual refers to making protocols. This
section is specific to the Solo syringe aspirate and dispense functions that are combined
with the 96 way head functions to set up a complete experiment.

1. Launch the Gryphon program and click Connect at the top of the £
screen. el Connect

2. Select File > New Protocol.

3. Click a plate name in the table on the lower right and drag it onto the plate position
on the deck where you will place that plate. Continue to click and drag plate names
until the deck is populated with the labware you need for your protocol.

If you accidentally drag a plate into an incorrect deck position, click on the deck
position to select it and then click Clear Plate. The plate positions can be modified
any time a protocol is not running by clicking on the Protocol Start bar.
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.| -
g8 .
1 2
Marienfeld
TR Glass Base

12 o
100 ]
1100

Clear Plate
MName |Maker |Type | A
TIEGEr Ceep vwel TITEgen Bl
Feserair Munc 96 Wells

S0-2 Crystal Plate Ihnowaplate 96 Wells
Single FoundWell Pro.. Corning 96 Wells
Smoked ClearPlate AR 304 Wells
Teflon Film Frame Meuro Probe 96 Wells
W-groowe Resendor Robbins 96 Wells

v

4. Click the first command you want to use in the protocol in the command area on the
left side of the screen and drag it into the Protocol Start area in the middle of the
screen. In this case, it is the Solo Dispense command. Refer to the Command
Descriptions for details.

e[ O
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5. For each command, click on the plate location on the deck where the command will
be executed. A representation of the plate’s well or wells will appear below the deck.
The plate in position 2 is selected in this example.

2
tarienfeld
Bl Glass Base

N

11

£l

I:L::ucation Rangel Alto H1Z J

Fill &1l Flate [ Gradient

Drap Yalume () |0 () Empty
PercentSpeed|1DD

Distance Abowve Bottom {mm) |D

Liquid Class|LCP

Fredispense [ ) |.1 TimesIE

The software automatically validates the protocol. If there is a
problem with any of the commands, a red alert symbol will pop
up next to the command field. Move your cursor over the
symbol to see the alert message. Generally the alerts appear
if the value provided for the command is out of range.

6. Click Save — on the toolbar to save the protocol. Other options are available
under the File Menu.
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Command Descriptions
The Gryphon provides commands, as shown at the left on the main menu. To execute

protocol functions, drag-and-drop commands below the Protocol Start bar. We describe
the LCP and Nano Syringe specific commands here:

Solo Dispense

The ARI Solo Dispense uses a positive displacement syringe to dispense LCP mixtures.

Sola Dispense Solo Syringe Dispense 0l drop in Tray 2

Drop Yolume () |0 (J Empty
Fercent Speed | 100

Distance Abowe Bottom () | 0

Liquid Class | LCF

Fredispense (g1 Times |5

Drop Volume—Volume to be dispensed in uL., if Empty is checked, syringe will empty its
contents.

Percent Speed—Speed of the deck between dispenses.
Distance Above Bottom (mm)—Height of the tip from the well bottom during dispense.
Liguid Class—Set to LCP by default.

PreDispense (uL)—Specifies the volume to be pre-dispensed onto the pre-dispense
glass slide in position 6, default is 0. Predispense specifies the volume, the same value
as intended to dispense, and the number of times you wish to prime the syringe tip. We
recommend 4-5 x during normal operation.

NOTE If a pre-dispense is chosen, a pre-dispense glass slide
must be placed in position 6 in the software protocol and
on the physical deck.

1.

Times—Specifies the number of pre dispenses.
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Solo Aspirate
The ARI Solo Aspirate uses a positive displacement syringe to dispense LCP mixtures.

Solo Syringe Aspirate 0 pl from Tray 13

Solo- Sspirate

Wolume (ply |0

Distance Abowve Bottom (o) |0

Liquid Class | LCF

Fredispensa (1|0 Tirnes |0
() AirGap | Volume (|

NOTE A long nozzle syringe is required to aspirate from the 8 vial
positions in the sample diluter rack postion 13.

Volume—Volume to be aspirated in uL.
Distance Above Bottom (mm)—Height of the tip from the well bottom during aspirate.
Liguid Class—Set to LCP by default.

PreDispense (uL)—Specifies the volume to be pre-dispensed back into the aspirate vial.

Times—Specifies the number of pre dispenses.

Air Gap—If checked, Volume specifies the amount of air gap to be aspirated.
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NanoSyringe

The ARI NanoSyringe uses the Nano (if present) as a positive displacement syringe to
dispense samples in a touch off mode.

I
H &
NanoSyringe ;.z Mano Syringe Dispense 0l drop in Tray 1

Drup\r’ulume[ul]h
Channel|1 C]F"urge,-"Empty I ALL - NONE I

Fercent Speed | |
Distance Abowve Bottam mm) | 0.1

Licquid Claasl Mano Syringe

Drop Volume—Volume to be Dispensed in uL.

Channel—Selected tip of multi tip systems, default is 1. If Purge/Empty is checked, that
tip will Purge syringe contents.

Percent Speed—Speed of the deck between dispenses.
Distance Above Bottom (mm)—Height of the tip from the well bottom during dispense.

Liguid Class—Set to Nano Syringe by default.
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Gradient Checkbox—If gradient checkbox is checked, unit will autocalculate a volume
based linear gradient and dispense per row, as specified in Edit Volume fields.

<l EditVolume
H0w| Begin ol | End Yol
F“U g 4 01 04
. B0 04
P [ 01 04
1 2 Dol 04
ntelli-Flate} | Marienfald E 01 0.4
FHell LP | [Glass Base F o1 04
G 01 04
H 01 04

[Location Rangel AltoH12 "]

Fill 4l Plate (M) Gradient

O

Tip Touch—Tip will touch off on the well sides as specified by all, none, or selecting the
appropriate arrows.

Tip Touch

| s wone |
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9. Run Protocols

Protocols are the Gryphon Instrument’s user interface and comprise the sequence of
commands that allow the device to carry out useful automated work in the laboratory.

Protocols can be developed to do simple tasks—like wash routines—or conduct complex
experimental maneuvers. They can be developed and saved, or modified and resaved.

Appendix A contains a sample protocol showing how the Gryphon “thinks” as it
completes an experimental setup.

1. Launch the Gryphon program. Click Open Protocol at the top left of the screen and
then select the protocol you want to run. Click Open Protocol at the bottom of the
screen. Note that you can also import or delete protocols, as well as cancel the
transaction.

|j Import Protocol .. | |j Delete Protocal J |j Cpen Protocol J |j Cancel J

2. Ensure that the correct labware is on the deck and that the solutions to be aspirated
are in the labware.

3. Click'SY at the top of the screen to run the protocol.

4. To stop the protocol at any time, click @ at the top of the screen.

10. LCP Functions

There are two LCP specific function buttons available at the top of the screen, Exchange
Solo Syringe and Mix LCP. Exchange Solo Syringe is used to allow the removal and
replacing of an LCP syringe. The Mix LCP function controls the built in mixing function
of the LCP unit.

Dock e Deck Exchange btz

"""‘\
/™ Connect — 11 Out / Saolo Syringe LCF

Exchange Solo Syringe

The Exchange Solo Syringe function is used to set up a prefilled syringe for LCP
dispensing, or to move the actuating arm out of the way if required, and placing or
replacing a syringe onto the LCP drive.

ACAUTION Connecting to the system with an LCP syringe plunger locked in

place may lead to a damaged/broken syringe, and loss of
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sample.

1. Click Exchange Solo Syringe at the top of the screen to run the function.
2. Ensure that the thumb screw is loose and not able to contact the syringe plunger

2. A control window will open outlining the steps to perform.

Solo Syringe Manual Drive Switch

Solo Syringe manual drive switch enabled.

13 Disengage Solo Syringe Plunger Locking Screw before actuating.
21 Raise FPlunger Actuator above plunger end before exchanging.

d1 Exchange syringe.

4y Lower Plunger Actuator and tighten plunger locking screw,

Sample Volume: 132.65 pul
Finish |

A

3. To remove a syringe already in place, disengage the thumb screw holding theSolo
Syringe Plunger. If a syringe is being placed in an empty unit, use the black rocker
switch to be sure the plunger lock is backed off far enough to allow the plunger
through when mounting the syringe.
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4. Place the syringe in the mating mount locations, point down if dispensing, and rock
top into spring loaded ball stop mounts, notice flat on syringe is facing out.

J‘ &

5. Lower plunger actuator until even with plunger end.

NOTE A long nozzle syringe is required to aspirate from the 8 vial
positions in the sample diluter rack postion 13.

Note: it is better to drive the plunger slightly down during the tightening process than to
allow the teflon seal to be lifted above the sample creating an air pocket.

6.
7.

8. Tighten actuator onto plunger end.
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9. You may choose to manually actuate the LCP syringe slightly to make sure sample
is at the tip, or you may perform a pre-dispense in the LCP protocol to accomplish
the same purpose.

10. Press Finish when done.
Mix LCP
The Mix LCP function is used to mix a prefilled syringe for LCP dispensing

ACAUTION Starting the system with an LCP syringe plunger locked in place

may lead to a damaged/broken syringe, and loss of sample.

1. The rocker switch controlling the syringe motion is active in this command, allowing
you to exchange or place a new syringe if required.

See exchange Solo Syringe section on how to mount syringe assembly.
The mounted syringe assembly should look like this:
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AHCAUTION Bottom syringe plunger of mixing assembly should be fully

depressed prior to mixing or it may lead to a damaged/broken
syringe, and loss of sample.

bl
4. Click on Mix LCP button. LR
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Mix Settings

1. Before loading the mixing assembly onto the Gryphon, force all fluid into the upper syringe,
such that the upper syringe plunger is at its largest extension and the lower syringe plunger is at
minimum extension {deally zero).

2. Load the mixing assembly {upper syringe oriented up) as normal using rocker control.

3. Press Mixwhen finished loading the syringe. Press Cancel to leave the syringe mixing action.

Max Speed: 10.00pL/s

- : Mix Region
(Spesd (s[5 ) ) Top 20%
(Loapsh J DA”

C] Continuous bix C] Bottorn 20%:

[ Fizx ] [ Sawve & Close ] [ Cancel & Close ]

5. The mixing protocol parameters are set here.
Speed—The mixing speed in microliters per second.

Loops—The number of full syringe strokes, up and down, to perform.

Mix Region—This setting allows mixing of only certain portions of the sample. Usually it
is used if the ends of a sample fail to mix well, in which case you can set the unit to
focus on the appropriate end..

Continuous Mix—This setting will continuously run the syringe until explicitly told to stop
by pressing the button marked Change. After pressing Change, the unit will continue to
move until the cycle it is running is completed.

LCP Mix ] LCP Mix

Fress Change to edit mix
parameters or to stop mixing.

fulize 1 bz B

A — 4

6. Press Save and Close if you'd like to save the parameters you've set.
7. Press Cancel and Close to cancel any changes you’'ve made.

8. Press Mix to perform the Mix protocol.

NOTE The system will finish the cycle it is working on when requested to
stop. Therefore choosing very small values of mixing speed may lead
to long waits for the system to complete its action.
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Appendix A Sample Protocol

The following protocol describes an LCP protein dispense. This procedure will show how to set
up an LCP dispense onto a glass plate..

ACAUTION| This is provided as an example only. Do not run this—or any
other protocol—on your system without first testing and

validating it.

When you have completed all the steps, your screen should look like this.

2 Gryphon 1.4.1.0 - New Protocol - New Protocol.pro®

File Corfiguration

Open N Run - Protocol - & g Ry P Deck - e Deck ™\ Exchange Mix
S Poo | & S0 Protocsl @ e Info Yoo (e X voiew £ oicomen g out ) SoloSyringe Lep
% = Protocol Start
) 1 Available Volume: 45.38 l
/ Solo Syringe Dispense 0,025 drop in Tray 2
Loon Pause
sepie o
e Excterge

Nenodspirse | | WanoDispense

wash NaroWash

0ja

Nanosyrnge | Solo Aspirae

5000 Dispense

Refer to the Command Descriptions section at any time for more detailed information on each
step.
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1. Launch the Gryphon System and Click Protocol Start to populate the screen. Drag-and-drop
plates from the Plate List onto the desired Deck locations. In this example, the Wash Flow
Thru station is in position 3, a Marienfeld Glass base is in position 2, and a Pre dispense Slide
1mm is in position 6.

[ Gryphon 1.4.1.0 - New Protocol - Mew Protocol.pro®

File Configuration 3

£ Open Fun B Froocl
S Poow & Soe Protocol @ sep | Jmm Jundo [ Redo F““

9
.13

1 2
Available Volume: 45.28 i e rphy tdarienfeld
Solo Syringe Dispense 0.025 ul drop in Tray 2 [Glass Base

500 ]

00

Name [aker [Tyme | &
192 Hal Carning 96 Wells

3 B-well Coming - 35.. Corning 96 Wells
3 R-vell Coming - 96 Corning 96 Wells
96 Block 1/2 Height Greiner 96 Wells

A6 Costar Costar 46Wells

96 Flat Battam Greiner 96 Wells

i.l.; 96 Greiner Round Bott.. Greiner 96 wells
¥ 36 Bottam Costar 35 Wells
Memarinel| (Gok prse Coming 5wellround.. Corning 96 Wells
CostarDeepds Costar 96 Wells

CrystalCuick -Found  Greiner 96 Wells
CrystalCuick -Square  Greiner 96 Wells
CrystalQuick LP Greiner 96 Wells v

2. This protocol only has one function: to dispense LCP onto the glass slide. Select the
function and edit the parameters.

[Locatiun Rangel AltoHIZ ']

Fill All Plate [ Gradient

Drop Valume (1) | 0.025 (JEmpty
PercentSpeed|1UU

Distance Abowve Baottom (rim) |D

Liquic Class|LCP v

Predispense(pl)lﬂ.‘l Times|5

)
Protocol

3. Press Run Protocol.
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